Chapter 8

Cost Markups and Adjustments

In M32, cost markups are defined as all of the percentages and adjustments added to
the base Direct Costs in an estimate. Markups can include overtime adjustments,
taxes, and price adjustments, as well as contractor and subcontractor markups, and
owner cost adjustments.

This chapter presents an overview of the process of defining cost markups, explains
the concepts involved in defining and computing markups, and presents reference
information on the M32 windows and tabs used.

e Cost Markups and Adjustments Overview
e Overtime

o Adjustments and Taxes

e Contractor Markups

e Owner Markups
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Cost Markups and Adjustments Overview

M32 allows you to apply multiple-levels of cost markups and adjustments, to any task or
folder in an estimate.

Markups Form

By highlighting any task or folder in the sheet or tree panel and then displaying the Markups
form, you can view or change the markup information for that task or all tasks below that
folder.

To display the Markups form

1 Inthe Project Database, highlight any folder or task in the tree panel or sheet panel.

2 Choose View > Forms > for Markups, or click the toolbar button.

CHILD DEVELOPMENT CENTER
{gﬁ Qvertimel ,@ Adjustments and Taxesl H% Qontractorsl E anerl

— EXTERIOR CLOSURE
Description .Q £ a -~
Sales Tax 6.50%
:t to Prime E
2 | OVERHEAD - GEMERALMPRIME 1 .R9% E 40| 45677 $0 $12.213
# |HOME OFFICE - GENERALYPRIM| 2.70% 4 $0] 2444 $0 $5.258
# |PROFIT - GEMERALAPRIME COM| 6303 b $0|  $5.857 $0 $12.600
% |BOMD - GEMERALNPRIME COMT | 1.21% . 300 $1.023 30 $2.200
# |EXCISE T [IF APPLICABLE] -1 1.50% $0)  $1.438 $0 $3.222
i o 0 $101.345 &
A |ESCALATION 4.36% 1 0| $4.422 $0 $9513°
#1 | COMTIMGEMCY 5.00% | $0| %5288 30 $11.377
A | 510H E.00% i $0]  $6.6E3 30 $14.335 LI
Quantity [1.0 [sF ™ Show Unit Costs Project Cost [$253,250.40
Task Court I_S‘d Back | Hext I LCloze I

Buttons and Controls
The Markups form provides these buttons and controls on all of its tabs.
Task This field shows the number of tasks included beneath the currently

Count selected folder (or “1” if the current selection is a task). This field is
displayed for all the tabs of the Markups form.
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Back Display the Markups form for the previous task or folder in the
database.
Next Display the Markups form for the next task or folder in the database.

Apply Apply any changes you have made on the form, and leave the form
displayed.

Close Apply any changes you have made on the form, and close the form.

Tip: You can also click the X icon in the upper right corner to close the
form. This method removes the form from memory and as a result
frees system resources. However, the form will be slower to reload
than if you click the Close button.

Summary Tab - How Markups Are Applied

As illustrated in the figure above, the Summary tab on the Markups form shows the
computed markup costs for the folder or task currently selected in the tree or sheet
panel.

The grid area summarizes the markups applied to each Direct Cost type in the
estimate, beginning on the top row with Bare Direct Costs and proceeding down to
Total Project Cost at the bottom.

1 Bare Direct Costs are the base costs recorded for a task, before any markups or
adjustments.

2 Costs applied to Bare Direct Costs can include price adjustments and taxes. Added to
bare costs, these markups equal the "full direct cost" for any task or folder; that is, the
cost to the sub or prime contractor who performs the work.

3 Next, overhead, profit, and other contractor markups are applied for each contractor
involved in the work. M32 allows you to define multiple levels of tiered contractors in an
estimate. A subtotal line shows the Costs to the Prime Contractor.

Note: Subcontractors are listed by name unless all of the tasks below the selected item
do not have the same subcontractor. In this case, a generic Subcontractors line is used
to summarize all subcontractor markups.

4 The Prime Contractor's own markups are then shown, with the next line of subtotals
being the Total Contract Cost or Cost to Owner.

5 Lastly, costs outside the contract, known as Owner Costs, are applied to result in the
bottom line cost, referred to as the Project Cost.
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Defining Markups and Adjustments

Defining markups and adjustments in M32 involves the following tasks:
Task  Description

1 You choose the cost type fields used for markups on the Select
Fields tab of the Project Summary Information dialog. These fields
can include predefined cost types that M32 computes in specific
ways, or cost types that you define.

Refer to Chapter 4 for more information on the Project Summary
Information dialog and the cost types.

2 In the case of contractor markups, you add contractors in the
Contractors primary view, and then assign tasks to them.

Refer to “Contractor Markups” in this chapter.

3 For non-contractor markups, you use the Markups form to define the
actual cost amounts or percentages to apply as markups. In some
cases you will define markups that apply to the estimate as a whole.
In other cases, you will want to define specific markups that apply
only to a certain task or folder.

Caution on Applying Markups to Folders

If you apply markups to a folder and later add more tasks to that folder, your markups
will not be automatically applied to the new tasks. You must manually reapply the
markups. You can run the Markups report to see which markups are applied to
specific tasks.
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Overtime

Overtime adjustments are typically applied to the Labor (and sometimes
EquipmentDirect cost types. They are applied before all other markups.

You define Overtime adjustments on the Overtime tab.

#" Markups for CHILD DEVELOPMENT CENTER
: ,@ Adjustments and Taxesl H% Qontractorsl E anerl

— Owertime

Shift D efiritions

Day || Working?

‘wiorking?

Ovwerride

—

Std Work Day |8, hours Stdwork Week |5 days

Falder

Task Count I 34 ﬁackl Next I Qpplyl Qlosel

Effects on Labor and Equipment Costs

When you apply an Overtime adjustment, M32 marks up the Labor costs for all affected
tasks by that percentage. Equipment costs are affected only if you are using the U.S. Army
Corps of Engineers equipment cost calculations as displayed on the equipment form (See
Chapter 7). In this case, the Ownership (FCCM) portion of the equipment cost for each task
is reduced by the percentage shown in the Equip FCCM % field on the Overtime tab.

Overtime Categories

M32 uses data that you enter on the Overtime tab to create Overtime categories. These
categories define the amount of overtime worked and the overtime differentials to be applied.
Based on this data, M32 computes an overtime percentage adjustment to be applied to all
Labor costs (and an Equipment FCCM percentage to be applied to Equipment costs) when
this Overtime category is applied.
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Field Descriptions

Overtime
Categories Area

Count

Overtime
Category

Percent

Configuration
Area

Days Grid

Shifts Grid

Hours per Day

Equipment FCCM
%

Standard Work
Day

Standard Work
Week

Tasks Grid

The grid area in the upper left part of the tab shows all of
the Overtime categories that have been defined for this
estimate. The currently selected category is shown by

the IIl icon

Number of tasks under the currently selected folder that
use this Overtime category. These tasks are displayed
in the tasks grid, below.

Description of the Overtime category

Percentage added to labor costs by this Overtime
category.

The area in the upper right shows the values used to
compute the Overtime percentage for the currently
selected Overtime category

The days included in the workweek and the amount of
Overtime adjustment for each day

The shifts worked and the number of hours in each shift

Total hours per day (the sum of the hours for the
specified shifts)

Percentage by which the Ownership component of
Equipment costs will be reduced (when using the U.S.
Army Corps of Engineers method of computing
Equipment costs)

Number of hours in a standard work day. That is, the
number of hours per day paid at the standard, non-
overtime rate.

Number of days in a standard week. That is, the
number of days per week paid at the standard, non-
overtime rate.

The grid area at the bottom of the tab shows all tasks
below the currently selected folder to which the selected
Overtime category is currently applied. The tasks are
shown with their parent folders and the associated Tags.
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Actions
You can take the following actions from the Overtime tab:

o To apply the selected Overtime category to the current task or all tasks under the currently
selected folder, click the Apply or Close buttons.

¢ To change the way Overtime is computed for the selected category, change the values in
the Configuration area and click Apply or Close. This updates Overtime adjustments for
all tasks to which this category has been applied.

e Toadd an Overtime category, click the blank Overtime Category field. Enter a name in
the Overtime Category field and then click another field on the grid. You can then select
values in the Configuration area. To apply the Overtime percentage to the current folder
or task, click apply. To exit without applying, click Close.

Example - Adding Overtime to Part of an Estimate

In this example, you need to define an Overtime category and apply it to all Roofing tasks in
your estimate.

1 Inthe tree panel, highlight the folder for Roofing.
2 Choose View > Form > for Markups.

The Markups form is displayed.
3 Click the Overtime tab.

4 Click on the first blank row in the Overtime Categories area. Type “Overtime” in the
Overtime Category field and then click on another field in the same grid.

M32 enters 0.00% in the Percent field. You can now access the Configuration area for
the new category.
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5 Enter the following information in the Configuration area
Day Working Select all

Paid At Enter 2.0 for Sunday and 1.5 for all other
days.

Shifts Working ~ Select #1 and #2
Shifts Hours Enter 8.0 for #1 and 7.5 for #2
Note: Do not change the other default values.
M32 computes the Hours per Day as 15 and computes the overtime percentage as
25.35%. It places this value in the Percent field in the Categories area. It also computes
an Equipment FCCM percentage of - 63.13%.
6 Click the Apply button.
M32 applies an Overtime markup of 25.35% to the labor costs of all tasks under the

Roofing folder. If you are using the Corps of Engineers’ equipment cost computations,
M32 also reduces the Ownership component of the equipment by 63.13%.
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Adjustments and Taxes

Cost adjustments are any percentage markups that you may wish to apply to a task

or folder in an estimate. Taxes normally represent sales tax on material and are
applied to the Material Direct Cost type . Both adjustments and taxes are applied

after any Overtime percentages and before contractor markups.

You define information for these markups on the Adjustments and Taxes tab.

Markups for CHILD DEVELOPMENT CENTER

™7 §ummary| {gﬁ Dvertime

~ EXTERIOR CLOSURE

p-4 Qontractorsl E anerl

B}

P |Sales Tax

Percent
£.50%

Folder
10 MASONRY 025140850 | Splash block, precast concrete, standard size
10 MaSONRY 041550050 | Joint reinf, steel bars, placed vertical, #3 & #4 bars
10 MASOMNRY 042340350 | CMU, back-up, 8"« 8" 2 16", no scaf/einf, 2000 ps
10 MASOMRY 042450100 | CHU, bord beam, 8 H, 8" thk, no scaf, no groutfre
10 MASOMRY 042602020 | Brick veneer, 4"« 2-2/3"x 8", std, red, incl waste, TL
03 ROUGH CARPEMTRY 061118401 T<| Wood Blocking
03 ROUGH CARPENTRY 0612010027 £| 142 In Thick Plwwood
in kAACTRIDN n7HcAcon dall el daid WL DA A Bl emnd T i :N-.LI

Task Court I 34

Back | Mext I Apply | Qlosel

Adjustment/Tax
Type

Definition Grid

Count

Description

Percent

This area in the upper left part of the tab shows all of the
adjustment and tax markups defined for the estimate.
These are the same as the Adjustment/Taxes types
selected on the Project Summary Information dialog,
Select Fields tab. The currently selected type is shown

by the EI icon

The grid area in the upper right shows the values for the
currently selected adjustment or tax.

Number of tasks under the currently selected folder that
have this adjustment applied. These tasks are displayed
in the tasks grid, below.

Description of the adjustment, (typically includes the
percentage added or deducted and why).

Actual numeric percentage of the adjustment
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Tasks Grid The grid area at the bottom of the tab shows all the
tasks under the currently-selected folder to which the
selected tax or adjustment is applied. The tasks are
shown with their parent folders and associated Tags.

Actions
You can take the following actions from the Adjustments and Taxes tab:

o To apply the selected tax or adjustment to the current task (or all tasks under the
currently-selected folder) click the Apply button.

¢ To change the way the tax or adjustment is computed, change the values in the Definition
Grid and click Apply. This updates the markup for all tasks in the estimate to which this
tax or adjustment has been applied.

Example - Defining Sales Tax for Materials
In this example, you need to define a 5.5% sales tax for all materials in your estimate. The
example assumes you have selected a Direct Cost type of Material and an
Adjustments/Taxes type of Sales Tax on the Select Fields tab of the Project Summary
Information dialog.
1 Highlight the top level folder for your estimate.
2 Choose View > Form > for Markups.

The Markups form is displayed.
3 Click the Adjustments and Taxes tab.
4 In the Adjustments/Tax Type area, click to select Sales Tax (if it is not already selected).

5 Enter the following information:

Description 5.5% Sales Tax on Material

o°

Percent 5.5
6 Click the Apply button.

M32 applies the tax . All Material costs in the estimate are increased by 5.5%.
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Contractor Markups

M32 offers great flexibility in defining and applying contractor markups. Contractors'
overhead, profit, and bond costs are figured individually for each contractor involved
in the project. The software automatically calculates these costs according to any of
a number of methods that you choose. You can apply markups for individual
contractors to any folder or task at any level in the project hierarchy.

Contractor markups are typically applied to all Direct Cost types. They are applied
after Overtime, taxes, and cost adjustments, but before Owner Cost markups.

Contractor Tiering

Prime and Subcontractors

In M32, a prime contractor is defined as one who does not work for another
contractor. A subcontractor is one who does work for another contractor.

M32 allows you to have more than one prime contractor defined in the project. M32
also permits you to define multiple levels of subcontractors, as in the following
example.

Level 1 - BC Building Construction (Prime Contractor)

Level 2 - EL Electrical (Subcontractor)

Level 3 - ES Electrical Specialties (Subcontractor)

In this example, Contractor ES works for Contractor EL, who in turn works for
Contractor BC. BC is a prime contractor, because he does not work for any other
contractor. BC is also considered the parent contractor to his subcontractor EL.
Similarly, EL is considered the parent contractor to his sub, ES.

Compounded Cost Markups

When M32 calculates the estimate, a subcontractor's cost markups are rolled in to
the costs applied to the parent contractor.

In the above example, the costs for work performed by ES will be applied to EL with
ES's markups included. Similarly, the costs for the same work will be applied to BC
with both ES's and EL's markups included.

In other words, M32 compounds the markups of tiered contractors, as is common
construction practice.
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Task List for Working with Contractor Markups

Working with contractor markups in an M32 estimate involves the following tasks:

Task

Description

1

You use the Project Summary Information dialog, Select Fields tab, to
select the Contractor Markup cost types and the types of Direct Costs
they apply to.

Refer to Chapter 4 for information.

You add the contractors to the Project Database, using the
Contractors primary view.

You apply the contractors markups to folders or individual tasks in the
estimate. By doing so you assign the folders or tasks as work
performed by that contractor.

Contractors Primary View

You use the Contractors primary view of the Project Database to add contractors and to view
the hierarchy of contractors in your estimate. This view is automatically created with the
Project Database. It contains only a default Prime Contractor folder and an Unassigned
folder until you add contractors.

NOTE: Every contractor in the view is created with two subfolders, called Overhead and Own
Work. These folders are explained below.

L"_o Cantractors d|

GEMERALNPRIME COMTRACTOR [PC

GEWERALVPRIME CONTRACTOR [PC]

I% Ol ok, - Aty
E| £0 ACOUSTICAL SUBCONTRACTOR

LBy OwnwWork - A5
EI CARPENTRY SUECOMTRACTOR
tl ELECTRICAL SUBCOMTRACTOR
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Defining Prime Contractors

You can use the default folder to define the first prime contractor in your estimate. If you have
multiple prime contractors, you can add folders for them at the same level.

1  Select the default prime contractor folder in the tree panel.

2 To define information for the first prime contractor, click the right mouse button and
choose Edit Folder from the context menu.

The Contractor form appears (see below).
4 Fillin the form with the contractor information.

5 Click Close to exit the form.

NOTE: To add another prime contractor at the same level, select the prime contractor folder
in the tree panel and choose Insert > Folder. Then select the New Folder and repeat
the procedure from Step 2.

Adding Subcontractors

You add subcontractors as folders below the prime contractor folder. The subcontractors are
thus defined as “child” folders to the prime contractor. As explained under “Contractor
Tiering,” above, you can define multiple levels of subcontractor folders representing “parent”
and “child” contractors.

1 Inthe tree panel, select the folder for the parent contractor under which you want to
define the subcontractor.

2 Choose Insert > Child Folder.
The New Folder appears in the tree panel.

3 Select the New Folder, click the right mouse button, and choose Edit Folder from the
context menu.

The Contractor form appears (see below).
4 Fillin the form with the contractor information.

5 Click Close to exit.
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Contractor Form

You use the Contractor form to add or edit information about a contractor.

Contractors for CHILD DEVELOPMENT CENTER

Profit.. | PT &I Motes|

r— Contractor Definition

Contractar [D IAA

Quantity |1 0 IEA j

Contractor Marne: IGE NERALSPRIME CONTRACTOR [PC)

Short Mame: IGENEHAL\PHIME Folder Tag |M

— Project Contractor Summarny

M arkup 0 Amount IS
OWVERHEAD Compute Ovhd BE3% |B63% | $175.213
HOME OFC Rurning Pct 270%|270% [$0
PROFIT Compute Profit E.30% |B.30% |$0
BOMD Bond Class B 1.21% |1.21% |30
EXCISETA Running Pct 1.50%]1.50% [$0 =l
Inzert | ™ Lock Back | Mewt | Apply | Lloze |
General Tab
Contractor
Definition

Contractor ID

Quantity/UOM

Contractor Name

Short Name

Folder Tag

Required code you assign to identify this contractor.
See “Suggested Contractor IDs”, below.

Optional. Quantity and unit of measure associated with
this contractor's work. Often, 1 LS (lump sum) is used.
Actual quantities may also be used.

By filling in this field you enable M32 to calculate a unit
cost for all work done by this contractor independent of
the unit costs of any particular task or folder.

Name of the contractor

Short version of the contractor name, as used on the
tree panel

Optional tag or code associated with this contractor
folder in the contractor hierarchy
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Project The grid area shows the summary of cost markups for

Contractor this contractor

Summary

Markup The Contractor Cost fields selected for this estimate on
the Project Summary Information dialog, Select Fields
tab.

Refer to Chapter 4 for information.

Method The method used to compute the contractor's markup
for each Cost field. See “Cost Methods” below for
information.

Own% Percentage markup for this Cost field applied to the

Contractor's own work

Sub% Percentage markup for this Cost field applied to the
Contractor's subcontracted work

Amount Amount of markup for this Cost field.

Note: Depending on the Cost Method, either an Amount
or Percentages may be used.

Cost Methods

M32 supports these methods of computing contractor markups. As indicated, certain
methods are only available for certain of the predefined Contractor Cost fields.

o Direct Pct - M32 calculates the markup using the percentage you enter in the Own % field
times the contractor's Direct Costs only. The same percentage is applied to the
contractors own and subbed work. This option is available for all Contractor Cost fields.

¢ Running Pct - M32 calculates the markup based on the percentage you enter in the Own
% field times the running total. (The running total is the total of the contractor's Direct
Costs plus the values of any Cost fields appearing above the present row in the grid.)
The same percentage is applied to the contractors own and subbed work. This option is
available for all Contractor Cost fields.

e Separate Pct - M32 calculates the separate markups for the contractor’'s own work and
subbed work, using the two separate percentages that you enter in the following fields.
This option is available only for the Overhead and Profit Cost fields.

e Amount - Add the amount that you enter in the Amount field. This option is available for
all Contractor Cost fields.

e Compute Overhead - Choose this option when you want to estimate the contractor's
overhead using tasks that you enter specifically for this contractor. See "Working With
Overhead Tasks," below. This option is available for the Overhead Cost field only.
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e Compute Profit - Choose this option when you want to compute the contractor's profit
using the Profit Weighted Guidelines table. See “Profit Tab,” below, for information. This
option is available for the Profit Cost field only.

¢ Bond Class Options - Choose these options when you want M32 to compute a bond
markup amount using a predefined Bond table and Bond Classes, which are maintained
by the M32 Administrator. These options are available for the Bond Cost field only.

Note: Administrators maintain the Bond Table using the M32 Administrator Module. If
you are an administrator, see Appendix A..
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Suggested Contractor IDs

Following is a list of recommended contractor IDs for common types of contractors:

AA — Prime Contractor

AB — Alternate Prime

AC — Acoustic Treatment

CA - Carpeting

CO - CO2 Fire Protection System
CS - Special Coating

CW - Cabinet and Casework
EL - Electrical

ES - Special Electrical Systems
EV - Elevators

FP - Fire Protection

FS - Food Service Equipment
FU - Furnishings

GL - Glass and Glazing

GW - Gypsum Wallboard

HA - Halon Fire Protection System
HC - Hoist and Cranes

HV - HVAC

IN - Insulation

LP - Lath, Plaster, Stucco

MA — Masonry

MB — Prefab Metal Buildings
MC - Controls

ME — Mechanical

MI — Instrumentation

Working With Overhead Tasks

MR — Membrane Roofing

PA — Partitions

PC - Precast Concrete

PL - Plumbing

PR - Preform Roofing, Siding
PS - Painting and Sealants
RF - Resilient Flooring

SC - Ceiling Suspension Systems
SD - Special Doors

SF - Special Flooring

SM - Sheetmetal

SR - Shingles, Roofing Tiles
SS - Structural Steel

ST - Soil Treatment

SW - Sitework

TB - Test and Balance

TE - Terrazzo

TF - Pile, Foundations

TI - Tileproof, Waterproof
WC - Wall Covering

WD - Windows

WF - Wood Flooring

WP - Dampproof, Waterproof
WW - Entrances, Windowwalls

When you choose Compute Overhead as the cost method for the Overhead cost
field, M32 will compute the Overhead amount by totaling the costs contained in
overhead tasks, which you enter for the contractor. Like other tasks in the estimate,
these tasks may include crews, assemblies, labor, and equipment, as well as CSI

tasks.

You enter these tasks in the Contractor primary view, under the sub-folder called
Overhead Items, which is automatically created when you add each contractor. You
can add as many levels of folders under the Overhead ltems folder as you wish.
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To enter Overhead costs for a contractor do any of the following

e Drag tasks from a CostBook, Assemblies, or another Project Database and drop them on
the Overhead Iltems folder

o Drag and Drop folders from other Project Databases onto the Overhead Items folder
o Insert tasks directly under the Overhead ltems folder

¢ Insert folders under the Overhead ltems folder, and then add tasks under those folders

NOTE: Computed Overhead tasks appear at the beginning of the Detail Report. I

Profit Tab

Use this tab to estimate the contractor’'s markup for profit using a profit weighted
guidelines table. This table is provided as part of M32’s support for U.S. Department
of Defense estimating procedures.

To use the table, you enter a decimal value for each factor listed. M32 multiplies
these values by the weights assigned to each factor to yield a profit percentage for
that factor. These individual profit percentages are totaled at the bottom of the
screen, and the sum is the profit percentage applied for the contractor.

NOTE: The weights listed for each factor can be adjusted by your System Administrator
through the Settings tab on the Administrator Options dialog.

The following guidelines for each weighting factor are copied from the Engineer
Federal Acquisition Regulation Supplement (EFARS).

Risk Degree of risk. Where the work involves no risk or the
degree of risk is very small, the weighting should be .03;
as the degree of risk increases, the weighting should be
increased up to a maximum of .12.

Lump sum items will have, generally, a higher weighted
value than unit price items for which quantities are
provided. Other things to consider: the portion of the
work to be done by subcontractors, nature of work,
where work is to be performed, reasonableness of
negotiated costs, amount of labor included in costs,
whether the negotiation is before or after performance of
work, etc.
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Difficulty

Size

Period

Contractors
Investment

Assistance

Subcontracting

Relative difficulty of work. If the work is most difficult
and complex, the weighting should be .12 and should be
proportionately reduced to .03 on the simplest of jobs.
This factor is tied in to some extent with the degree of
risk. Some things to consider: the nature of the work,
by whom it is to be done, where, what is the time
schedule, etc.

Size of job. All work not in excess of $100,000 shall be
weighted at .12. Work estimated at between $100,000
and $5,000,000 shall be proportionately weighted from
.12 t0 .05. Work from $5,000,000 to $10,000,000 shall
be weighted at .04, and work in excess of $10,000,000
at .03.

Periods of performance. Jobs in excess of 24 months
are to be weighted at .12. Jobs of lesser duration are to
be proportionately weighted to a minimum of .03 for jobs
not to exceed 30 days.

To be weighted from .03 to .12 on the basis of below
average, average, and above average. Things to
consider: amount of subcontracting, mobilization
payment item, Government-furnished property, method
of making progress payments, etc.

Assistance by Government. To be weighted from .12 to
.03 on the basis of average to above average. Things to
consider: use of Government-owned property,
equipment and facilities; expediting assistance, etc.

To be weighted inversely proportional to the amount of
subcontracting. Where 80% or more of the work is to be
subcontracted, the weighting is to be .03 and such
weighting proportionately increased to .12 where all work
is performed by the contractor's own forces.
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PT&I Tab

Use the PT&l tab to calculate a percentage to mark up the contractor’s labor costs to
account for payroll taxes and insurance. This percentage is applied to all labor costs
assigned to the contractor and is used to determine the value of the PT| Contractor
Cost field.

FICA (SS tax) Percentage to markup the contractor’s labor costs for
FICA

Unemployment / Percentage markup for Federal Unemployment
Federal insurance

Unemployment / Percentage markup for State Unemployment insurance
Federal

Workmen’s Percentage markup for Workmen’s Compensation
Compensation insurance

Total Payroll Total markup. Equals the sum of the preceding fields.
Taxes and

Insurance

Contractor's Own Work Folder

The Own Work folder is automatically created for each contractor that you add. This
folder shows the hierarchy of subfolders and tasks representing work performed by
this contractor (as opposed to subcontractors). This folder is empty until you assign
work to the contractor.

Assigning Work to a Contractor

When you assign work to a contractor, M32 applies the defined markups for that
contractor to the costs of the work. You can assign work to a contractor using several
methods.

e You can drag tasks or folders from another primary view of the project to the
Contractors view and them drop them on the Contractor's Own Work folder. This
is the easiest and recommended method.

e For individual tasks, you can use the Accounts tab of the task form to select the
contractor.

e For individual tasks, you can type the Contractor ID in the sheet panel.
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Result: After you have assigned a task or folder to a contractor, you can select that

task or folder in the sheet panel and then view the contractor markups on the

Contractors tab of the Markups form.

Contractors Tab, Markups Form

You use the Contractors tab on the Markups form to view the contractor markups for a
particular project folder or task. Unlike the other tabs on the form, you can view markups

here but not change them.

Markups for CHILD DEVELOPMENT CENTER
7 §ummary| igﬁ Qvertimel ,@ Adjustments and Taxes

— EXTERIOR CLOSURE

Count Contracto wlork
AEE B GEMERALMPRIME COMTRACTOF $182.533) B.69% 270% B.30% 1.21%
AS ACOUSTICAL SUBCONTRACTOF 40| 8.00% 7.00%
Cs CARPEMTRY SUBCOMTRACTOF $0)8.00% 7.00%

Falder

EL ELECTRICAL SUBCOMTRACTOR

40| 8.00% 7.00% _ILI
»

MASOMNRY 025140850 | Splash black, precast concrete, standard size
MaASONRY 041550050 | Joint reinf, steel barz, placed vertical, #3 & #4 bars
MASOMNRY 042340350 | ChU, back-up, 8"« 8" » 16", no scaf/reinf, 2000 ps
MASOMRY 042450100 | CHLU, bond beam, 8" H, 8" thk, no scaf, no groutfre
MaSOMAY 042602020 | Brick veneer, 4'"x 2-2/3"x 8", std, red, incl waste, TL
ROUGH CARPENTRY 061118401 T¢| ‘wfand Blacking

ROUGH CARPENTRY 0B1201002T¢| 142 In Thick Plywood

MASOMRY 072161660 | 'Wall insul, rigid, 2" thi, R14.4, foil faced, 2 sides, iza
INSULATION: “wall 072180160 | wall/ceiing insul, 6" thk. R19, 15" %W/, fbals, kraft fa
MaSONRY 076243300

Flashing, sst, paperbacked 2 sides, .005" thick LI

Task Count I 34

Back | Mext I Qlosel

Contractors grid The grid in the upper part of the tab shows all of the
contractors defined for the estimate, along with the
following information. The currently selected contractor

is shown by the

icon

Count Number of tasks under the current folder that this
contractor is currently responsible for

Tag Code or database ID used to identify this contractor in

the database

Contractor Name of the contractor
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Work Total costs of all tasks within the current folder assigned
to this contractor. (These are the Direct Costs to the
contractor, including Overtime, adjustments, and taxes,
as well as the markups of any subcontractors to this
contractor.)

Contractor Cost The following fields in the grid are the Contractor Cost

Fields fields defined for this estimate. Each field shows the
current markup percentage or amount as defined for this
contractor. (These values are defined in the Contractors
primary view, using the Contractor form.)

Tier The position of this contractor in the contractor
hierarchy. Prime indicates a prime contractor. Other
values are 1st tier sub, 2nd tier sub, etc.

Own Work Amount of the Work figure representing this contractor's
own work
Subbed Work Amount of the Work figure representing work that this

contractor subcontracts

Tasks Grid This grid on the tab shows all tasks under the current
folder to which the selected contractor is currently
applied. The tasks are shown with their parent folders
and associated Tags.
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Owner Markups

In M32, Owner markups are used to estimate costs to the project owner outside of
construction contracts. They are applied after all other markups. Owner markups
may include escalation, contingency, supervisory costs, and so on. Like other

markups, they are distributed over all or part of a project.

Some Owner markups, such as Escalation, are normally defined at the top-level
folder and thereby applied to the entire estimate. Others, such as Contingency
markups, may be applied only to certain folders or tasks. The recommended
procedure is to apply the top-level markups first and then to apply any additions or
exceptions at the lower level folders or tasks.

You define Owner markups on the Owner tab:

Markups for CHILD DEVELOPMENT CENTER

§ummary| igﬁ Qvertimel ,@ Adjustments and Taxes :/o LContractors

— EXTERIOR CLOSURE

wher Markup Type
ESCALATION

CONTINGEMCY

SIOH

Falder

10 MaSONRY 025740850 | Splash block, precast concrete, standard size

10 MASOMNRY 041550050 | Joint reinf, steel bars, placed vertical, #3 & #4 bars

10 MASONRY 042340350 | CMU, back-up, 8"« 8" 2 16", no scaf/einf, 2000 ps

10 MASONRY 042450100 | CMU, bowd beam, 8 H, 8" thk, no scaf, no grout/re

10 MASOMRY 042602020 | Brick veneer, 4"« 2-2/3"x 8", std, red, incl waste, TL

03 ROUGH CARPENTRY 061118401 T¢| Wfood Blocking

03 ROUGH CARPENTRY 0B1201002T &l 142 In Thick Plwoad LI
ESCALATIOM: Start Date |D1 0141996 Index (1994, End Date |D?£D1 /1997 Index |2DS1 .

Task Count I 34 Back | Hext I Apply | Cloze I

Owner Markup This area in the upper left part of the tab shows all of the
Type Owner Cost types defined for the estimate on the Select
Fields tab of the Project Summary Information dialog.

The currently selected type is shown by the icon.

For More Information on the Owner Cost fields, see
Chapter 4.
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Definition Grid The rows in this grid (in the upper right of the tab) shows
all of the markups defined in the estimate for the
currently selected Owner Cost type. For example, if
three different Contingency markup percentages are
defined for three different areas of the estimate, all three
are shown in the grid. The currently selected markup is

shown by the selection icon !

Count Number of tasks under the currently selected folder to
which this Owner markup is applied

Description Description of the markup. Typically includes the
percentage added or deducted and the Owner Cost
field.

Method Method used to compute the Owner markup. See “Cost
Methods” below for information.

Percent Actual markup percentage applied. Depending on the
Method, you may enter the percentage here or M32 may
compute it.

Amount Amount of markup for this Cost field.

Note: Depending on the Method, either an Amount or
Percentages may be used.

Tasks Grid This grid area on the lower part of the tab shows all
tasks under the current folder to which the selected
Owner markup is applied. The tasks are shown with
their parent folders and the associated Tags.
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Escalation These fields appear at the bottom of the tab when you

Fields select Compute Escalation as the Method for the
predefined Escalation Cost field. You enter Escalation
table values that M32 then uses to compute an
escalation percentage to apply as the markup.
Escalation tables are available from a number of
industry and government sources, such as:

R.S. Means Company

Engineering News Record

F.W. Dodge

U.S. Government Office of Management and Budget
U.S. Army Corps of Engineers (Form AR 415-17)

Note: The Date of the Escalation Schedule is printed in
the Project Settings Report and the Markups Report.
See Chapter 9 for more information on Reports.

Start Date Date represented by the Index in the next field.
Index Index at which to begin calculating Escalation costs.
End Date Date represented by the Index in the next field.
Index Index at which to end calculation of Escalation.

The End Index is divided by the Start Index to compute
an escalation factor representing the relative cost
change between the two indexes. This factor (minus
one) is then applied as a running percentage to yield the
percentage value for the Escalation field.
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Methods

M32 supports these methods of computing Owner markups. As indicated, certain methods
are only available for certain of the predefined Owner Cost fields.

Direct Pct - M32 calculates the markup using the percentage you enter in the Percent field
times the total contract costs only (that is, total Direct plus all markups up to the "Cost to
Owner" row as shown on the Summary tab). M32 excludes other Owner Costs from the
computation. This option is available for all Owner Cost fields.

Running Pct - M32 calculates the markup using the percentage you enter in the Percent
field times the running total. The running total is the total of all Direct Costs and markups
including any Owner markups listed above this one on the Summary tab. This option is
available for all Owner Cost fields.

Amount - M32 adds the amount you enter in the Amount field. This option is available for
all Owner Cost fields.

Compute Escalation - M32 computes the percentage based on Escalation data that you
enter on the bottom of the tab. Available only for the Escalation Cost field.

Actions

You can take the following actions on the Owner tab:

To apply an Owner markup to the current folder or task, select the Owner Markup type,
select a row in the Definition grid, then click the Apply button.

To add a new markup percentage or amount, first select the Owner Markup type, then
click a blank row in the Definition grid and enter a Description, Method, and Percentage or
Amount.

To change information about an Owner markup , select the markup and change the data
in the Definition Grid.

Example - Defining a Contingency Percentage

In this example, you need to define a 6% Contingency for the Sitework in an estimate. You
want this markup applied after Escalation. You have already defined Escalation and
Contingency as Owner markup types on the Select Fields tab of the Summary Information
dialog. (Contingency is entered as a User-Defined Owner field.)

1

In the tree panel, highlight the Sitework folder.

2  Choose View > Form > for Markups.

The Markups form is displayed.
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3 Click the Owner tab.
4  Click to select the Contingency type in the Owner Markup Type grid.

5  Click in the Definition grid and enter the following information:

Description 6% Contingency for Sitework
Method Running Percentage
Percent 6%

6 Click the Apply button.

M32 applies the 6% Contingency percentage to all Sitework tasks. The markup is
applied to Escalated contract costs for the work.
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